# Table of Contents

Getting Started – Logging Into the WCMS ................................................................. 4
   System Essentials ........................................................................................................ 4
   Delete/Restore Assets .................................................................................................. 4

Additional Content Tools ............................................................................................... 6
   Blocks .............................................................................................................................. 6
   Creating a Block ............................................................................................................ 7
   Adding Blocks to a Page ............................................................................................... 8
   Changing Content For An Existing Block .................................................................... 9
   How To (Not) Publish A Block .................................................................................. 11

Lightboxes ....................................................................................................................... 12

Working With PDFs ......................................................................................................... 14
   PDF Properties ............................................................................................................ 16

Images in WCMS ............................................................................................................ 17
   Full Width Banners (banners above content and navigation): .................................... 18
   Images In Content Area, 3 column layout ................................................................. 19
   Images Within Content Area, Expanding Navigation Style ........................................ 20
   Images In Content Area, Thin Navigation Style ......................................................... 21
   Images In Content Area, Thick Navigation Style ....................................................... 22
   Bottom Blocks ............................................................................................................ 23
   Customizing the Footer Block .................................................................................. 24

Metadata Tab ................................................................................................................... 26
   Metadata Backstory and Checklist ........................................................................... 27

Page Expiration ............................................................................................................... 30

External Links .................................................................................................................. 31

External Link in New Window ........................................................................................ 32

Reference Links ............................................................................................................. 33

Unpublish Before Rename ............................................................................................. 35

Check-Out (Lock) and Check-In (Unlock) of Assets ....................................................... 39

Organizational Tools ...................................................................................................... 43
   Version Compare ........................................................................................................ 44
System Name/Parent Folder Resides within Move/Rename Tab ............................................................... 45
Delete .......................................................................................................................................................... 45
Getting Started – Logging Into the WCMS

Cascade Server is the University of Central Oklahoma’s Web Content Management System (WCMS), which allows for the organization and management of website content across the organization.

To start using the system, you must first log in by visiting:

[http://wcms.uco.local/](http://wcms.uco.local/)

System Essentials

**Session Timeout**
If your WCMS session is inactive for 60 minutes you will be automatically logged out by the system. Your work is not automatically saved, so please make sure you Submit (save) your work when you leave your computer.

**Auto-Save**
WCMS does not currently have the ability to auto-save your work. If you have been working on an asset for a long period of time, Submit (save) it periodically.

**Assets Named “index” Should Not Be Renamed or Deleted**
You must have a page with a system name of “index” (lowercase) for any of the navigation to appear, as well as for web browsers to display your site properly. For any page named “index,” do not rename it or delete it – this will severely damage your WCMS navigation. Contact the UCO Help Desk if you have questions.

**Delete/Restore Assets**
WCMS includes a “Recycle Bin” which will temporarily store deleted files. Storage is not permanent and all items will be purged after 15 days.

**Assets cannot be recovered after 15 days from date of deletion.**
Getting Around – Navigating the WCMS

There are multiple ways to navigate in the WCMS, including the Dashboard, the Menu Bar, Quick Links, and the Asset Tree.
Additional Content Tools

Blocks

Blocks are reusable pieces of information. They can be used to draw attention to an event, showcase images or point out important links. They can be used on multiple pages within a website. Blocks can also be shared within a department, or with other departments at UCO.

XHTML Block – This section allows you to replace or add additional blocks to your page. Please continue to the next section for more information on blocks.

Blocks are reusable pieces of content that can be easily substituted (with or without styling) into any page region. This allows content to appear in many pages while always being updated from one place, making it easy to maintain consistency across many pages. A single block can be reused an unlimited amount of times. You can also choose a background color for your block.
Creating a Block

To create a new block in the WCMS:

1. Select the folder you wish to place the new block in. This is the “_internal/blocks” folder found in your website’s folder.

2. In the Menu Bar, select New > Default > Block.

3. On the Create New Block page, choose XHTML Block and submit.

4. Under the Metadata Pane, add a Display Name and Title (and any other fields if necessary). The Display Name is what will show up in the Navigation Pane of your website, and the Title will show up in the breadcrumbs and at the top of your web browser.

5. Under the System Pane, add a System Name. The System Name will show in the Asset Tree and should be something meaningful and not include spaces.

6. Under the Content Pane, you will see the Content Editor. Add the content for your block here.

7. Select Submit to save your block.

Tip: Use the “Heading 3” for headline of your Block – this is the perfect size!
Adding Blocks to a Page
A block must be created, or already exist before you can add it to a page. Blocks, once created, can be positioned in a variety of locations on your web page. Locate the XHTML Block area of the page you are editing.

1. Locate the XHTML Block area of the page you are editing.

2. Navigate to the Block you want to add, and click “Confirm.”

3. Now that you have added a Block, select the Style from the Drop Down menu.

4. If applicable, select the location. Some blocks can be positioned on the left or right of a page.

Note: You can have more than one block on a page. Use the “+” to add a new XHTML area for a block.
Changing Content For An Existing Block

If you are working on an asset that already contains blocks, you will need to locate them so you can make changes

Part I - Locating

1. Edit the page where the block resides. Make a mental note of the block you want to update.

2. In Edit mode, scroll down the page and look for the block that you want to update. Make a note the location of the block content. This is the name and location of the block you need to edit.

In this example, the block is located here: academic-affairs/_internal/blocks/aa-studentinfosheet
3. We have located the block, since we are not making any edits to this page, click Cancel.

![Advanced Options](image)

4. All that is left to do is to navigate to the block’s folder, and edit.

**Part II – Using the Asset Tree & Editing**
Blocks are usually located in: your-sitename/_internal/blocks

![Asset Tree](image)

(It is not always necessary to perform Part I when you know the location of the block)

1. Once the block has been located use the Asset Tree to navigate to it. In the example above, we go to: academic-affairs > _internal > blocks > aa-studentinfosheet
2. Click the block, then click Edit.

3. Make updates.

4. Submit changes. Then return to the original web page (in Part I) to view the changes.

How To (Not) Publish A Block

Blocks by themselves can’t be published.

However when you publish a page, WCMS will publish every block used on that page.

Anytime you make changes to a block, you will need to republish your pages (or site) to Staging and, once you approve, to Production to be able to see the updated block content online.

To view your updated block content, follow these steps:

1. Edit your block(s).
2. Publish each page utilizing the block to Staging and verify the new content is present.
3. Publish each page to Production.
Lightboxes

Lightboxes are pop-up windows that you can use to display photos or other content. If you will be using an image in your Lightbox, you will need to upload your image to the Web Content Management System before it will be available for you to use. For more information on uploading images, refer to the “Uploading Files” instructions in the WCMS – User Guide [Essentials] document.

Creating Lightboxes

This section allows you to create a pop-up window to display photos or other content. To create a Lightbox on your page, be sure to upload your images first (see the section on uploading files), and follow these steps:

1. In the Lightbox sections of your page, fill out each field.
   - For the ID field, give each instance of the Lightbox effect its own unique entry. Do not use any punctuation or spaces (required).
   - For the Image field link to any image you have uploaded (optional).
   - Link is used with Link Label to display a name for the link (optional).
   - Link Label is the blue link text that will appear at the top of your lightbox.
2. Make a link to activate the Lightbox pop-up.
   - Scroll up to find the Content Editor.
   - Locate or add text and make it into a link by highlighting the text.
   - Click the Insert/Edit Link tool on the toolbar.

3. A new window will open for Insert/Edit Link. In the top field, “Anchor,” enter the unique ID for your Lightbox created in Step 1.
   
   NOTE: In Internet Explorer the text next to the fields may not be visible. They do appear in Firefox. However, this has no impact on your link – just put the ID in the top entry field.

4. In the Class dropdown, select “lightbox.”
5. Click Insert/Update.
6. To view your lightbox in action, you must first Submit (save) the page.

You can have multiple Lightboxes on your website. Just click the “+” to add more, or the “-” to remove.

**Note:** Each Lightbox must have a unique ID.
Working With PDFs

Changing Content of a PDF without Breaking Links

With WCMS, there is no need to delete an uploaded file when you are asked to replace it with a revision! Any asset in WCMS can be edited or updated by making a simple upload. This can be a huge time-saver when you just need to update one PDF on a website.

The biggest benefit of this procedure is that the file name will always stay the same, resulting in fewer broken links from search engines.

To update the contents of an asset without changing the file name, follow these easy steps:

1. Locate the asset to be updated.

2. Select the asset and then click **Edit**.

3. Select **File Upload** and browse to the location of your updated asset.

4. Navigate to the asset on your computer, flash drive or network share.

5. Select the asset and click **Open** – this will return you to the WCMS edit screen.
6. Click **Submit** to upload the new file to WCMS.

7. The new file will replace the file currently in WCMS but the file name will remain the same.
8. Publish the updated file to Staging, verify it then publish to production.

**Bonus: Download an Asset**

Any asset can be downloaded from within WCMS. Just follow the same procedure described above, but instead of Edit, select **Download**.

Once you’ve downloaded an asset, you can edit it and upload the changed file back into WCMS.
PDF Properties
Open Adobe Acrobat pro, then go File > Properties.

On this screen you can update the Metadata for the PDF including Title, Author, Subject and Keywords.

Many times a PDF will be created from a Word document. As a result, the information in the Word document will be brought over into the PDF.

It is important to check and revise these fields before publishing in WCMS because this data will display in search results.

To add copyright information, select Additional Metadata.
Images in WCMS

Image Dimension Recommendations
When uploading images, it is important to follow the following rules for dimensions. (Note: All dimensions are in pixels).

Image sizes listed are for WCMS sites using standard UCO designs. WCMS sites using customized designs should refer to specifications provided with your site delivery. Be consistent with image sizes, determine the best size for your site and make that the standard for all pages.

This guide represents a variety of designs and options available in WCMS. Not all aspects presented are available in every WCMS site.

NOTES:

File Size: The system allows for a maximum image file size of 0.5 megabytes.

RGB: When saving images in Photoshop, be certain to save in “RGB Color” and not “CMYK Color.”

Although Safari, Chrome, Opera and Firefox are all capable of displaying CMYK images, Internet Explorer will not. To ensure all browsers can display your images, always saved in RGB.

To verify this setting, just open Photoshop and go Image > Mode > and select RGB Color.
Full Width Banners (banners above content and navigation):

- Width: 950 (max)
- Height: 161 (or greater)

Full width banners are available on some WCMS designs.

This image can be changed on a page-by-page basis by locating the “Page Banner” section when editing a page.
Images In Content Area, 3 column layout

Banner Images

- Width: 450 px
- Height: 180 px

Images

- Width: 450 px

Dimensions for images are placed in the WYSIWYG content editor above any text.

To add an image above the content, use the Insert/Edit image tool.
Images Within Content Area, Expanding Navigation Style

Banner Images
- Width: 620 px (max)
- Height: 125 px (or greater)

Images
- Width: 620 px (max)

Dimensions for images are placed in the WYSIWYG content editor above any text.

Add an image above content in WYSIWYG using the Insert/Edit image tool.

Images in blocks below the navigation

<table>
<thead>
<tr>
<th>Image with Style “None”</th>
<th>Image with Style (such as “Maroon”)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width: 290 px (max)</td>
<td>Width: 250 px (max)</td>
</tr>
<tr>
<td>Height: 290 px (or greater)</td>
<td>Height: 250 px (or greater)</td>
</tr>
</tbody>
</table>
Images In Content Area, Thin Navigation Style

Banner Images

- Width: 692 px (max)
- Height: 125 px (or greater)

Images

- Width: 692 px (max)

To fill the entire width of the content area, use an image no wider than 692 pixels.
Images In Content Area, Thick Navigation Style

Banner Image

- Width: 625 px (max)
- Height: 125 px (or greater)

Images

- Width: 625 px (max)

Images in blocks below the navigation

Image with Style “None”

- Width: 288 px (max)
- Height: 288 px (or greater)

Image with Style (such as “Maroon”)

- Width: 250 px (max)
- Height: 250 px (or greater)
**Bottom Blocks**

270 x 270, or less, for each bottom block

**Example:** With Burgundy, Yellow and Dark Green “with dots” style applied.

Note that the center block is wider by design.

Example: With **None** selected as a style.
Customizing the Footer Block

The links at the bottom of each page in your site can be customized by editing a single block. Once changes are made to the footer block, all pages will be updated instantly with the new footer.

1. To Edit a Footer block, locate the _internal/blocks folder

2. Locate the block named “footer,” select it and edit.
3. The footer is just a bulleted list. It becomes a horizontal list when the block is displayed on the web page.

4. Make any edits or additions, and Submit the block.

**Note:** After making changes, you will need to republish your ENTIRE website so that all pages are updated with the new footer.
Metadata Tab

Keywords
The Metadata Tab gives you the ability to have more control over how your pages appear in search engine results, such as Google or Bing.

By default, the following are already included as keywords on every UCO page:

UCO, University, Central, Oklahoma, Live, Central, State, College, Higher, Education, Bronchos, Buddy, Broncho

WCMS gives you the ability to additional information to the keywords area.

At this time Author, Summary, and Teaser are not enabled.

Keywords:

Description: A 250 character explanation of the page and its contents. Since some characters are already in use by the University, this leaves a reduced amount available.
Metadata Backstory and Checklist

In the early days of search engine optimization, marketers focused on meta-tags as the primary way to attract search engine traffic. Meta-tags are HTML tags that help describe the document they are located within. Today we know that search engines not only look at meta-tags, but a site’s content, internal link structure and link popularity.

Meta-tags are still an important tool for successful search engine marketing. Search engines focus on three primary tags to help them determine the relevance of a website for a particular search phrase.

**Title Tag**
The Title Tag is one of the most important tags for a search engine. The Title Tag should describe exactly what the document contains. It should contain keywords, but not repeats, of terms you hope to be found for. It should also be as readable as possible. You must consider that the Title Tag will be the first thing someone sees if you appear in a search result.

The Title field can entered when you Edit a page asset.

![Inline Metadata](image)

**Description**
The description for a website is a 250 character explanation of the page and its contents. It should contain keywords and phrases you hope to be found for, but it should also read like an introductory lead-in for the topic or service you are highlighting. The Description Tag is another call to action.

Your Description and Title Tag together should be compelling enough to generate a click through from a search result. You have to put yourself in the search engine visitor's position. They are looking for something very specific. The description you provide for your page has to convince the person that you are providing exactly what they are looking for. If a user comes to your site and the Title and Description Tags don't accurately match the content they actually find, you are less likely to be considered a reputable source of information.
Keywords

The last meta-tag that is important to search engines is the Keyword Tags. Keyword Tags should contain less than 250 characters including spaces and use important keywords and phrases consistent with the HTML Body Text and Page Title. No single word should be used more than twice.

Keyword Tags should contain realistic keyword terms that you hope to compete for. The more generic the term you include in your keywords, the more likely you are to be swimming in an ocean of 7 million other documents. Being specific and accurate are the ingredients to success with keywords. It’s important that any keywords you use in your meta-tags actually exist in the pages they are used for.

As previously mentioned, the following are already included as keywords on every UCO page and do count towards the 250 characters:

UCO, University, Central, Oklahoma, Live, Central, State, College, Higher, Education, Bronchos, Buddy, Broncho
Metadata Checklist

Title:

- Provides call to action - YES/NO?
- Contains less than 80 characters - YES/NO?
- Uses important keywords and phrases - YES/NO?
- Describes what the page is about - YES/NO?
- Consistent with other content components - YES/NO?

META Keywords:

- Contains less than 250 characters - YES/NO?
- Uses important keywords and phrases - YES/NO?
- Minimal repetition of individual words - YES/NO?
- Consistent with other content components - YES/NO?

META Description:

- Provides call to action - YES/NO?
- Contains less than 250 characters - YES/NO?
- Uses important keywords and phrases - YES/NO?
- Describes what the page is about - YES/NO?
- Consistent with other content components - YES/NO
Page Expiration

WCMS include the ability to set assets to expire.

Expiration sends email notices to the last user to edit the page. In addition to the actual "this page has expired (and moved, if applicable)" notice, WCMS also sends warnings about pages about to expire. A first warning goes out 5 days before expiration, and a final one 1 day before expiration.

The benefit being, when a page hits its expiration date, “Include when publishing” and “Include when indexing” are both automatically unchecked. This essentially removes the page from navigation.

As a result, the next time the site is published, the page will no longer be visible in navigation.

Note: None of the expiration features have any effect at all on what has already been published to production. When a page expires, it is NOT unpublished from the server.

Review Date: The review date is the date and time for the page to be submitted into a workflow associated with the field. If no workflow is found, then nothing will happen.

Start date: If set, prior to this date, the page cannot be published and does not appear in indices (ie, it won’t show up in navigation structures, etc.).

End date: If set, after this date, a page cannot be published and no longer appears in indices.

Expiration folder: If a folder is set, the page will moved into a specified folder. It is recommended the destination folder be set not to publish.
**External Links**
A unique feature of WCMS is the External Link. This allows you to add a link to your Navigation, even if the page is not part of your website.

The main purpose of this type of link is to enable non-WCMS pages show up in the navigation.

1. Start in the folder where you want the link to reside. Then, click New > External Link.

2. Enter the Display Name (this will appear in your navigation) and the Link.

3. On the System Tab, give the asset a system name.
4. When the asset is created, it will have a globe for an icon.

5. Just like any link, an External Link can be relocated in your navigation (see “Reordering Navigation Links”).
External Link in New Window

To make an External Link (for navigation), open in a new window, click on the Metadata tab.

Look for **Target** and select **New Window**. Submit the asset and republish your site to make the change active.
Reference Links

A Reference is a special asset that points to an existing asset in another location. The Reference Link appears in navigation as if it were in multiple locations, in actuality, it directs back to the original asset.

References are often used to have links show up in navigation menus in other folders than where the page actually resides.

1. Once you are on the page which you want to appear in your navigation, page, click on Advanced -> Reference.

2. The Reference screen will give you two options:

   a. **System Name** - The name as it will appear in the Asset Tree. It is recommended to leave “reference” in the system title, and add the name of the page immediately following.

   **Example**: reference-aa-home-page

   b. **Parent Folder** - The location in which the reference will reside. **You must update this option** and select the folder that is receiving the updated navigation. Otherwise, the Reference will be created inside the same folder as the asset you are working with.

   **Note**: You cannot currently change the Display Name of a Reference Link. References will always use the Display Name of the original asset.

3. After setting the options, submit the page.
4. The Reference Link is now created!
5. Once created, the asset with be the last item in your navigation. To relocate the asset in your navigation structure, please review the **Reordering Navigation Links** section of this guide.
Reordering Navigation Links

Reordering assets is sometimes necessary in the WCMS. If you need to change the order of assets:

1. Select the folder that holds the assets you want to reorder.
2. The folder contents are listed and you can use the Action buttons in the far right column to move each asset up or down the list. This order will affect how pages are shown in Navigation Pane on your site.
3. Assets can also be reordered using the drag and drop method. Simply click Order at the top of the screen. Then click next to the asset name and drag and drop it to its new location. The order will be automatically updated.
Unpublish Before Rename

When you are working on an asset that seems to be in the wrong location, or has a system name that needs to be changed, please un-publish the asset before taking any action. Otherwise the old version will always remain on the UCO website.

Only when an asset is un-published will it be completely removed from www.uco.edu. In WCMS an “asset: refers to any file, folder, image, block or page that is part of your site.

Follow this procedure to successfully move/rename a published asset:

1. Locate the asset you want to move/rename.
2. Copy (select and CTRL+C) the asset name and paste into an email.
3. Send the email to support@uco.edu and request that the asset be unpublished from UCO.edu
4. Once you receive and email notification that your ticket has been closed, you may proceed to move/rename the asset.
5. After you move/rename the asset, publish to Staging.
6. Verify the changes by visiting http://preview.uco.local then navigating to your site.
7. Note that when you move/rename an asset, it is a best practice to re-publish your entire site so all pages are refreshed with the updated location.
8. Once satisfied with your changes, send a new request to support@uco.edu and request the asset (and/or site) be published to UCO.edu.

Following this procedure will ensure that outdated pages and documents are not displayed when web visitors are searching uco.edu.

Note: There may be a slight delay in search web sites like Google in catching up with the change. Please allow a few days for such sites to update their links.
Drafts

The **Save As Draft** feature allows users to save drafts of assets that they are editing in order to return later to finalize changes.

The ability to periodically save a draft of an edit in progress serves as a valuable safeguard against accidental loss of work due to a browser crash or an accidental click. And since the Save As Draft feature is beneficial system-wide, it’s enabled for all users and for all content types.

**Button Functions**

The buttons below are located at the bottom of each asset capable of utilizing Draft.

Displays before clicking Save Draft

![Buttons](image)

Displays after clicking Save Draft

![Buttons](image)

**Submit**: Commits changes to the asset permanently.

**Save Draft**: Performs a temporary save of your work.

**Update Draft**: Temporarily saves any changes made since the last Save Draft.

**Discard Draft**: All changes made in the Draft session are removed and no changes are made.

**Cancel**: Draft changes since last Save Draft are retained, but no permanent update is performed.
Save As Draft - Important Details

- Save As Draft allows you to temporarily save your work without clicking Submit each time.
- This allows you to remain in the Edit Mode of your work.
- Only by clicking Submit are changes to the asset made permanent.
- Drafts can be discarded. If you Discard a Draft no changes will be saved.
- Discarded Drafts cannot be recovered.
- Drafts of one individual WCMS user cannot be viewed another individual.
- If you accidentally click away from an asset while in Draft, your work is not lost. Click back to the asset and click Edit. You can recover all work made before the last time you Saved a Draft.

- Selecting Discard Draft gives you the option to change your mind.

- If two people are editing the same asset, whoever clicks Submit first will create the new version. The individual who clicks Submit on a Draft after that point will see this message:

- To view a Draft or the Current version, use the links in the Viewing section.
Draft Benefits & Warnings

Save as Draft allows for the following functionality:

- Multiple users may save drafts of a single asset.
- View drafts just as you would a working copy in the editing interface.
- Submission of final draft into workflow works as usual.

Benefits of Save as Draft

- Users do not lose changes to an asset when viewing or editing other assets.
- Allows multiple users to edit a single asset at once.
- Edits/changes are saved in the database and not reflected in the current version of the asset, so that edits/changes are not published by automated publishes.

Warnings:

The original asset can still be edited and submitted by anyone with appropriate access while you are working on a Draft.

It is very possible that one person could overwrite the work of someone else.

There is NO MERGING of different Drafts – the first to hit Submit wins.

It is strongly recommended that those managing websites in a Team environment utilize the Lock > Check-Out option to ensure no other edits can happen while you work on a page. Lock/Unlock is detailed in the following section.
Check-Out (Lock) and Check-In (Unlock) of Assets

WCMS enables users to exclusively "check-out" (lock) assets when working on them. This prevents others from submitting changes. An asset must be "checked-in" (unlocked) before other users can edit it again. When you LOCK one of your pages or other assets, you make it un-editable to all other users.

View Locked Assets

To quickly view your locked assets, click on Home in the top navigation menu.

Locks are displayed on the dashboard, as they are for each user, under both the Locks tab and Current Activity on the main dashboard.
Check-Out (Lock) an Asset

When you LOCK one of your pages or other Assets, you make it un-editable to all other users on Cascade Server.

1. Using the Asset Tree, navigate to the Asset you would like to check-out.
2. Under the View tab, click on Lock.
3. Click Check-out This Asset.
4. Look for the “Operation Successful” message.
5. You will be returned to the Layout pane, with the Working Copy currently showing.
6. An asset that is check-out will display the following links:
   - Current - view the current version of the asset
   - Working Copy - view the checked-out working copy
   - Compare with Current - compares the content of the working copy with the current version
7. To begin editing the asset, select Edit.
8. While editing a Locked Asset, **Working Copy** will display at the top of the page.

![Working Copy Screenshot]

9. Individuals who attempt to edit a locked Asset will see this message:

![Locked Asset Screenshot]

10. Once editing is complete, **Submit** the asset.

11. The final step is to **Check-In (Unlock) the asset**, as detailed in the next section.

**Note:** If an asset is checked-out and the owner is not available to check-in, the Office of Information Technology can break the lock.

However, breaking the Lock will discard any changes made by the individual who locked the asset.

Please send an email **support@uco.edu** for assistance.
Check-In (Unlock) An Asset

1. On the View tab of an asset, select the Lock pane.

2. Select and perform one of the following Actions:

- **Commit changes** - finalizes the edit and removes the exclusive lock on the asset. If you selected to commit changes, you will be prompted to add comments to the new version before submitting.

- **Break the lock and discard changes** - discards the changes and removes the lock

- **Send into workflow** - starts a workflow using the working copy of the asset. After selecting this option, you will be prompted to select one of the available workflows.
Organizational Tools

Copying one Web page to create another, viewing and accessing versions of Web pages, reordering navigation links, and deleting and moving assets are all part of the Organizational Tools available to you.

Copying a Page

Copying a page is simple way to create new content.

1. Select the page you wish to copy.
2. Select the Copy Tab at the top of the page.
3. Create a new System Name for your page and choose a new parent folder, if necessary.
4. Click Submit.
5. Your new page appears in its parent folder. Follow the directions for Editing a Page to make changes to it.

Comparing and Activating Different Versions

As changes are made to any asset in the system, WCMS tracks the changes in separate copies of the asset called Versions. These are accessed by clicking “Advanced” and selecting “Versions.”

The versions list for each asset shows a list of each version, the author for each change, including the original creator of the asset, as well as the time and date of the change and any notes available. Users may navigate through the various versions, compare them with the current version, and activate any version desired. Each version has a timestamp that allows the user to see when the change was made.
Version Compare
Since WCMS saves a version of your asset each time you click Submit, you can utilize the Compare function’s ability to color-code to easily identify changes.

1. To compare one version to the most recent, simply access the Versions function on the More tab.

2. Select any previous version by clicking the asset’s name.

3. To compare one version with the most recent, select Compare with Current.

WCMS will display both versions of the page and highlight any differences with the following rules:

- Text that has been added is highlighted in green.
- Text that has been removed is highlighted in pink and is struck-through.
- Modifying text is considered as old text removed and new text added.
- Changes and updates to markup (i.e. change from bold to italic) is highlighted in purple.
System Name/Parent Folder Resides within Move/Rename Tab

WCMS enables you to rename or move via the Move/Rename tab.  

**Note:** Without proper planning, this process have a detrimental effect on the state of published content.

![Move/Rename tab](image)

Moving Assets

If you need to move pages, images, or files (even folders) this is easily accomplished by editing the asset:

1. Select the item you want to move in the Asset Tree.
2. Click the Edit Tab.
3. Select the Move/Rename tab.
4. Click on the Parent Folder.
5. In the Folder Selection window, select the folder where you want to move the asset.
6. Click Confirm.

Delete

The Delete function is located on the More tab and can also be found on the Context Menu.

![Delete function](image)
Advanced Options
Right above the Submit button is the Advanced Options section. Click the arrows >> to open this section and view the options.

Version Comments
You can use the Version Comments section for brief notes about why you edited the asset, like “corrected spelling on staff list.” To add comments, go to the Edit screen and scroll down to the bottom. Click the Submit button to save. These comments do not appear on your web page, but they are saved with the file and displayed in the Versions list.

WCMS saves a version of the page each time you click Submit, so if something goes wrong, you can contact your Website Manager and request that an earlier version of the page be restored.

Check: Links
The link checker is checked by default, and ensures that all pathways from the current asset to other assets in WCMS are valid, and is invoked after an edit is committed by clicking the 'Submit' button. If the checker detects any broken links (which includes any relative links, as these are not valid within the CMS), it opens a page detailing these errors and providing several options for dealing with them.

Check: Accessibility
The accessibility checker is not checked by default. Checking it causes the system to verify that the web page meets accessibility requirements. For more information about the Accessibility Check, see WCMS User Guide 2-0 [Essentials].
Check: Spelling
You can check the spelling on every section of your page, all at once, by selecting the “Check Spelling” box in Advanced Options. **Note:** This option is not automatic, and will need to be selected again each time you Submit (save) a page.

However, you can check the spelling on every section of your page, all at once, by selecting the “Check Spelling” box in Advanced Options. **Note:** This option is not automatic, and will need to be selected again each time you Submit (save) a page.

The Spelling tool is invoked after a page edit is committed by clicking the 'Submit' button. If there are any words that WCMS deems suspect, you will be presented with a 'Spell Checker' page listing the errors sorted by the field on the page in which they occur.

For each error, you are presented with a link (to see the error in context), and radio buttons offering four options:

- **Change To** - This allows a 'change to' either a most-likely value as determined by the spell checker or a user-supplied alternative.

- **Suggested** - This allows the user to choose from a list of possible replacements suggested by the spell checker.

- **Ignore** - This allows the user to disregard the error altogether. This is the default option.

- **Add** - This allows the user to disregard the error AND add the term to the dictionary.

**Note:** These errors must be dismissed or corrected as appropriate before the page is saved.
Tips and Tricks

Email links
To make a clickable link that uses an email address, follow this simple process:

1. Type your text, highlight it and click the Insert/Edit link button on the toolbar.

2. Click on the External tab, and click in the Link box.

3. Type mailto: plus the email address, like this: mailto:bbroncho1@uco.edu
4. Click Insert/Update

You now have a link that contains an email address instead of a Web address.
Line Breaks and Double Spaces

Just like in Microsoft Word, when you hit enter the Content Area will produce a double-spaced line break, or paragraph break. This is often called a hard return.

However, if you would like your lines to be closer together, you can add a line break (also called a soft return).

Just click Shift and while holding it down, click Enter.

The lines will now be closer together, giving you a line break as a result.
Keeping Extra Spaces and Line Breaks
By default, WCMS will remove extra spaces, line breaks and empty paragraphs. Sometimes you may wish to retain these elements. To keep them you will need to disable Tidy HTML.

1. Above the Submit button, click “Advanced Options.”

2. Uncheck “Tidy HTML”

3. Click Submit.

**NOTE:** You will need to repeat this process each time you save the page. If you forget to uncheck the box, Tidy HTML will remove the extra spaces and paragraphs.
Tables

Adding Borders To An Entire Table

1. Select the table needing borders.

2. Right click and select Table Properties.
3. In the Class drop-down menu, select **with-borders**.

4. Select **Update**.

5. Borders have been added to the entire table.
Copy Rows

At times you may have a row in a table with the perfect styles and you need a new row just like it. A quick way to get the results you want would be to copy that row of cells.

1. Locate a row in a table
2. Click in one of the cells
3. Right click and go Row > Copy Table Row

4. Now place your mouse cursor on the row where you want the “new” row to be.
5. Right click and go Row > Paste Table Row Before or Row > Paste Table Row After

6. Delete the contents of the pasted Row, and add your new content to the cells.
Adding Padding to A Table Cell

Padding can be added to a table by either selecting a Style for the entire table or manually setting the padding on each cell.

Apply Padding To An Entire Table

1. Locate the table that needs padding.

2. Right click the table, and select Table Properties.
3. Select the Class dropdown.

4. Select **Padded Cell**.
5. Click **Update** to apply the padding to the entire table.

Manually Set the Padding in a Table

1. In the Table cell where you need extra padding, right click inside it.

2. Then **Cell** then Table **Cell Properties**.
3. In the popup, select **Advanced**.

![Advanced tab in popup](image)

4. In **Style**, type (or paste): **padding: 5px;**

5. Now select **Update**.

![Update in popup](image)

Repeat this process for each cell as needed.
Use of Embedded Content
From Section 2.3 of the UCO Web Presence Guidelines:

Embedded Video
All videos embedded into webpages, under the uco.edu domain, must use the embed code provided by the Office of University Relations' Video Services and the Office of Information Technology's Media Services in order to maintain ADA Compliance.

Content Contributors who wish to embed information or media from 3rd party sites, including RSS feeds and video which may require an external link, must provide disclaimer statements and/or exit pages prior to providing the media, and will be held responsible for the intended and subsequent content of those links. Inappropriate content found on UCO-affiliated sites, services or other linked content is the responsibility of the Content Contributor to facilitate removal.

Content contributed by UCO employees to UCO-affiliated websites, services, social networking mediums or videos must adhere to the terms and conditions outlined in the university's Responsible Use of Technology.

http://www.uco.edu/technology/policies/web-presence-guidelines.asp

Vanity URLs

Domain
Marketing domains, sometimes called vanity domains, are often used for marketing due to the ability to publish short, ‘catchy’ web addresses in print and electronic mediums. For example, a website’s address may be www.uco.edu/college/department/program/index.html and the marketing domain would be www.UCOprogram.com. Marketing domains are not part of the UCO.edu domain; they are often .com, .info, etc. Marketing domains may be requested by completing this online form: http://broncho2.uco.edu/domains/Request.aspx

URL or Sub Domain
A sub domain such as “program.uco.edu” is considered a marketing tool as well, and sometimes referred to as a marketing or vanity url (but not domain unless in the context of SUB domain). Marketing or Vanity URLs are requested through a service desk request by emailing support@uco.edu. There is no additional cost associated with the sub domain; however, requests will still be evaluated according to availability and alignment with the university marketing strategy.
Section 508 Requirements
This section details accessibility features that are available in WCMS. All web content, e-publications and online applications should be made available to individuals with disabilities. [For details regarding Section 508 compliance, visit the related government Web page at: http://www.section508.gov/.

Screen readers can only convey information in a text format. This means that you must provide text alternatives (“alt”) for all non-text elements. From Section 2.8 of the UCO Web Guidelines:

In 1998, Congress amended the Rehabilitation Act to require Federal agencies to make their electronic and information technology accessible to people with disabilities. Under Section 508 (29 U.S.C. § 794d), agencies must give disabled employees and members of the public access to this technology that is comparable to the access available to others.

In 2004, the State of Oklahoma enacted HB2197 (Title 62 O.S. § 41.5t) which requires state agencies, including the University, to comply with Section 508. Additional information on HB2197 can be found at http://www.ok.gov/abletech/IT_Access/HB_2197.html.

Note: This document is not inclusive of all Section 508 web requirements, and web account holders are responsible for verifying that their pages meet accessibility guidelines.

The university’s web content management system can assist with compliance of this guideline through the use of the Accessibility Checker, ALT attributes for images and Summary attributes for tables.

Accessibility Checker
WCMS includes an Accessibility Checker, which operates much like the spell checker and the link checker. It must be invoked manually after a page edit is committed by clicking the Submit button.

If there are any elements that the WCMS deems suspect, the user is forwarded to an Accessibility Checker page listing the errors sorted by the field on the page in which they occur.
The Accessibility Checker will report on common errors such as `<table>` elements without summary attributes as well as `<img>` tags without alt attributes.

**Simple Data Tables**

In a simple data table, the data has a one-to-one relationship with the header cells; i.e., one column and/or row header per data cell.

<table>
<thead>
<tr>
<th>Numbers</th>
<th>Apples</th>
<th>Oranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Produced</td>
<td>101</td>
<td>333</td>
</tr>
<tr>
<td>Sold</td>
<td>97</td>
<td>293</td>
</tr>
</tbody>
</table>

In WCMS, when creating or editing a table, the Summary can be added by clicking the “Advanced” tab. This is where you will place a brief summation of the data being presented. Be sure that the summary attribute provides a synopsis of the data.

To add more accessibility, click on the HTML tab, and add the `th` tag to all header cells. Then add the `scope` attribute to each header cell and/or row.

This would have your top row, describing each item, looking like this:

```html
<th scope="col">Numbers</th>
<th scope="col">Apples</th>
<th scope="col">Oranges</th>

<th scope="row">Produced</th>
<td>…
```
Complex Data Tables
In a complex data table, the data has a many-to-one relationship with the header cells; i.e., multiple column and/or row headers per data cell.

Development and markup of complex tables is beyond the scope of this manual, but the following resources are recommended:


http://wac.osu.edu/tutorials/bestpractices/tables.htm

Tables with Borders
When you create a new table in WCMS, it will not have borders. But you can easily add borders to a table.

1. Click the Insert/Modify Table button on the toolbar.
2. On the “Class” dropdown, select “with-borders”

To the right is an example of how a table will look either with, or without, borders in the WCMS editor.
Complex Images

Images with complex content (graphs, paintings, maps, organizational charts, diagrams, etc.) require more detail than is available in an alternative text area.

In this situation, the image should be described in detail on the web page that contains the image. This is considered a best practice because the information is available to all users.

The alternative text should still be used, but with a brief description.

Note that in the example above, the data contained in the pie chart image is also presented in within the text portion of the web page.
Publishing Your Website

Publish a Page or Folder for Preview
Changes made to your web page can be viewed on the WCMS Preview site. This is an exact representation of what your web pages will look like on the UCO website.

Websites and web pages on the Preview server are not visible to anyone outside of the UCO computer network.

The advantage to Preview is that you can make as many changes as needed, and preview them, before your website goes “live.” To see your published page or site, visit this link:

http://preview.uco.local/

http://facpreview.uco.local

http://studentpreview.uco.local/

To be sure you are in the right location for your web page, enter your specific website information in the address. For Information Technology, the URL would look like this:

http://preview.uco.local/technology/

Notes:
• Just as with WCMS, you must be on the UCO network to view the Preview website.
• Page changes will not be visible until the page is published.

Procedure to Publish a Page or Folder to Production
“Publishing to Production,” “publish live” or “going live” are all terms used to indicate that a website or web page is ready to be visible to the world. When your website is complete and ready for publishing “live,” follow these steps.

1. Send an email to support@uco.edu
2. In the subject line, enter WCMS: Publish (name of your site or page)
   example: WCMS Publish: University Relations website
3. In the body of the email, include the web link to your site or webpage.
   example: Please publish our website to production: www.uco.edu/university-relations
4. Send the email message.

You will receive a response from Information Technology when your request has been completed.
Submit a Page

In WCMS, Submit has the same meaning as “Save. If you are submitting a page, then you are saving it. It submits the page you just edited to workflow (if enabled).

After editing content, you must submit it. You can select Save Draft to save your edits to Drafts (you can access Drafts from your Dashboard), or you can select Submit to put your edited page into Workflow.

Workflow

Workflow is the process by which an email will be sent to your Approver, notifying them of the new or edited page.

Once implemented, the Approver will then access the page on the WCMS and either approve and publish the updates, or you will be notified of additional edits needed.

Every page must be reviewed by a “second set of eyes.” No one will be their own approver.

Your page will not be published to www.uco.edu until it has been submitted to Workflow and approved.

**NOTE:**
Currently workflow is not fully implemented within the WCMS. You will need to establish your own “second set of eyes” review and approval process within your department.

For example, your supervisor may wish to review your web updates before the pages are sent to the public website. This can be accomplished by publishing the pages to the “Staging” (Preview) server. Then, you can send a link to your supervisor for a review of the website.

Once workflow is available, you will receive notification and we will work with you to set up your processes.
Publishing Pages

1. To publish a page to the Preview web server, locate the page, and click the “Publish” tab.

2. Click “Submit.”

3. WCMS will display a confirmation message.
Publishing Folders

There may be situations where an entire website, and all pages and folders need to be published.

1. In the Asset Tree, click the Folder you wish to publish.

2. Click “Publish.”

3. Click “Submit.”
Working in WCMS at Home

The SSL-VPN (Secure Socket Layer, Virtual Private Network) is a means by which you can connect to the UCO network from the comfort of your own home (or anywhere else on the Internet). By using the same credentials you login to your UCO computer with and a web browser, you can be connected and ready to work within minutes! To request access, please follow these steps:

1. Visit http://www.uco.edu/technology/forms/
2. Locate and click the link to the Employee Security Access form.
3. On Page 1, complete the top section; on Reason for Request put “SSL-VPN access to use WCMS.”
4. On Page 2, have it signed by a Supervisor.
5. Send the form to Technology Support at Campus Box 122 or deliver it to MCS building, 175.
6. Once your request has been processed, follow the instructions found in the VPN section of the Networking Services web page. http://www.uco.edu/technology/catalog/networking.asp

Please note, once you have successfully logged in to the SSL-VPN, you must start Net Direct or you will not be able to access WCMS.

Once the Net Direct client has successfully started, open a new browser window (or tab) and visit http://wcms.uco.local.
Additional Training Sessions Available for Web Content Management

**Computer Basics**
If your basic computer skills aren’t quite what you’d like them to be, this session will help you to strengthen your skills so that you can get more out of your computer usage. Learn to organize and locate documents, work with the Windows XP operating system, and use shortcuts and tips to help you be more productive and effective on your computer.

**Image Editing with Office Picture Manager**
Using Microsoft's Office Picture Manager you can resize, modify, edit, and otherwise adjust pictures to get them just the way you want them. In this beginning level session, you will learn to use Picture Manager to turn your photos and graphics into images you can upload to Web pages, email to others, or use them in other documents where size and quality matter.

**Web Content Management Essentials**
If you are tasked with creating, editing, or maintaining one of the many UCO website pages but don't know where to begin, this training session is for you. In this session you will learn how to navigate the Web Content Management System (WCMS), create and edit web pages on your site, copy and paste content, create links to other Web pages, upload and add files, add images, and publish your Website. Attendance at this session is required for enrollment into the WCMS Advanced training session.

**Web Content Management Advanced**
*Prerequisite: WCMS Essentials.* In this session, UCO Website contributors and editors learn advanced Web Content Management System functions, including how to create content blocks and Lightboxes to enhance your Website pages, follow the UCO style guidelines, ensure web pages are Section 508 compliant, work with various website assets, reorder content, create email links and tables, embed videos, and much more.

**Web Content Management Special Topics**
*Prerequisites: WCMS Essentials and WCMS Advanced.* This course covers special topics related to creating content on UCO’s Web content Management System, such as portfolios.

**Adobe Acrobat Pro**
Acrobat Pro allows you to create and share PDF documents. This beginner-level session will provide an overview of how to use Acrobat Pro to easily create PDF documents from a variety of sources.

For more information or to enroll in a course, contact the Technology Resource Center at 974-5595 or trc@uco.edu, or visit the UCO Learning Center at http://learningcenter.uco.edu.
Contact Us:

Technology Support

Phone: 974.2255 (CALL)
Email: support@uco.edu
Location: MCS 172
http://support.uco.edu

Technology Resource Center

Phone: 974.5595
Location: ADM 101
http://trc.uco.edu

Office of Information Technology

Phone: 974.2688
Location: ADM 102
http://technology.uco.edu